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Precautions
Location
Using the unit in the following locations can result in a malfunction.

•In direct sunlight
•Locations of extreme temperature or humidity
•Excessively dusty or dirty locations
•Locations of excessive vibration
•Close to magnetic fields

Interference with other electrical devices
Radios and televisions placed nearby may experience reception interference. Operate 
this unit at a suitable distance from radios and televisions.

Handling
To avoid breakage, do not apply excessive force to the switches or controls.

Care
If the exterior becomes dirty, wipe it with a clean, dry cloth. Do not use liquid cleaners 
such as benzene or thinner, or cleaning compounds or flammable polishes.

Keep this manual
After reading this manual, please keep it for later reference.

Keeping foreign matter out of your equipment
Never set any container with liquid in it near this equipment. If liquid gets into the 
equipment, it could cause a breakdown, fire, or electrical shock. Be careful not to let 
metal objects get into the equipment.

THE FCC REGULATION WARNING (for USA)
This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide rea-
sonable protection against harmful interference in a residential installation. This equip-
ment generates, uses, and can radiate radio frequency energy and, if not installed and 
used in accordance with the instructions, may cause harmful interference to radio com-
munications. However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio or television recep-
tion, which can be determined by turning the equipment off and on, the user is encour-
aged to try to correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the 

receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

Unauthorized changes or modification to this system can void the user’s authority to oper-
ate this equipment.
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Copyright Disclaimer for JamVOX
JamVOX is a professional device and is intended for use only with musical works and sound 
recordings for which you yourself own the copyright, for which you have received permis-
sion for use from the copyright holder(s), or are in the public domain.

If you are not the copyright holder of a musical work or a sound recording and you have not 
received permission from the copyright holder(s), you may be violating federal copyright 
law if you produce and distribute CDs or other sound recordings, broadcast, publicly per-
form, sell, or make other unauthorized use of the copyrighted works. Infringers of copy-
righted works may be liable for monetary damages and other penalties. If you are unsure 
about your rights, please consult a copyright attorney.

YOU UNDERSTAND AND AGREE THAT YOU WILL BE SOLELY RESPONSIBLE FOR 
ANY LICENSES, CONSENTS, WAIVERS, PERMISSIONS AND/OR OTHER AUTHORIZA-
TIONS THAT MAY BE REQUIRED FOR THE USE OF ANY MUSICAL WORKS AND/OR 
SOUND RECORDINGS.

YOU EXPRESSLY UNDERSTAND AND AGREE THAT UNDER NO CIRCUMSTANCES 
WILL VOX AND KORG BE LIABLE FOR ANY INFRINGEMENT COMMITTED BY YOU 
USING ANY VOX OR KORG PRODUCT; VOX AND KORG SHALL NOT BE LIABLE FOR 
ANY DAMAGES, INCLUDING WITHOUT LIMITATION, ANY INDIRECT, SPECIAL, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES, ANY LOST PROFITS, LOSS OF GOOD-
WILL, OR ANY OTHER DAMAGES, HOWSOEVER CAUSED, AND ON ANY THEORY OF 
LIABILITY, RELATING TO OR RESULTING FROM THE USE OF, OR THE INABILITY TO 
USE, JAMVOX OR ANY OTHER VOX OR KORG PRODUCT.

Data handling
Incorrect operation or malfunction may cause the contents of memory to be lost, so we rec-
ommend that you save important data on a CD or other media. Please be aware that VOX 
will accept no responsibility for any damages which may result from loss of data.

• Mac and the Mac logo are registered trademarks of Apple Inc., registered in the U.S. and 
the other countries.

• Windows XP and Windows Vista are registered trademarks of Microsoft Corporation in 
the U.S. and the other countries.

• All product names and company names are the trademarks or registered trademarks of 
their respective owners.

Notice regarding disposal (EU only)
When this “crossed-out wheeled bin” symbol is displayed on the product, owner’s man-
ual, battery, or battery package, it signifies that when you wish to dispose of this product, 
manual, package or battery you must do so in an approved manner. Do not discard this 
product, manual, package or battery along with ordinary household waste. Disposing in 
the correct manner will prevent harm to human health and potential damage to the envi-
ronment. Since the correct method of disposal will depend on the applicable laws and r eg-
ulations in your locality, please contact your local administrative body for details. If the 
battery contains heavy metals in excess of the regulated amount, a chemical symbol is dis-
played below the “crossed-out wheeled bin” symbol on the battery or battery package.  
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Introduction

Thank you for purchasing the VOX JamVOX. To help you get the most out of your 
new equipment, please read this installation/setup guide and the owner’s manual 
provided in the installation CD, and use the product as directed.

Contents of the package
This product includes the following items. After you open the package, check that 
all items are present. If any are missing, please contact VOX distributor.

• JamVOX Monitor

• USB cable

• Installation CD (contains JamVOX Software, Drivers, and Owner’s manual)

• Two audio CDs (karaoke songs for guitar)

• JamVOX installation/setup guide (the document you’re reading)

Main Features
• Complete software modeling of famous amps and effect units with the realism 

you expect from VOX, the legendary guitar amp manufacturer.

• Guitarist-friendly music player with numerous convenient functions for jam-
ming and practicing.

• Revolutionary new GXT (Guitar XTracktion) function cancels or isolates the 
guitar parts of existing songs, fulfilling the dream of all guitarists.

• Comes as a set with the high-quality JamVOX Monitor that you can use simply 
by connecting it to your computer’s USB port and plugging-in your guitar.

• Comes with thirty guitar karaoke tracks that every guitarist knows (recorded 
by Hal Leonard Corporation, USA).

Caution
• The software license agreement for this product is included on the installation 

CD. You must read this license agreement before you install the software. Your 
installation of the software will be taken as your acceptance of this agreement.
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JamVOX Monitor
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The JamVOX Monitor is a 2-in/2-out USB audio interface and powered monitor 
with two 3-inch full-range speakers.
It can also be used as an audio interface for any software that supports CoreAudio or ASIO.

Do not connect the JamVOX Monitor to your computer before install-
ing the JamVOX Driver and Software.

Front and rear panels
You must turn down the volume of your equipment before you make connec-
tions. If you neglect to take this precaution, you risk damaging your speaker 
system and other equipment, or causing malfunctions.

Front panel

1. GUITAR IN jack
Connect your guitar here.

2. MIC IN jack
Connect your dynamic mic here. The mic can be used simultaneously with the guitar.

Only a dynamic mic can be connected; condenser mics that require a power 
supply cannot be connected.

3. MIC INPUT LEVEL knob
Adjusts the input level of the mic.

4. OUTPUT LEVEL knob
Adjusts the output level of the rear panel LINE OUTPUT jacks.

If the JamVOX monitor’s volume is insufficient, you can connect its LINE 
OUTPUT jack to your audio system.

Mic

Headphone

Guitar

1 2 3 4 5 6 7
5
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5. PHONES jack
Connect your headphones here.

6. MONITOR LEVEL knob
Adjusts the volume of the internal speakers and the headphones.

7. POWER ON indicator
This will light when the JamVOX Monitor is connected to your computer via USB, 
and the power is on.

Rear panel

1. USB connector
Use the included USB cable to connect this to the USB connector of your computer.

2. EXPRESSION PEDAL jack
Connect an optional Korg EXP-2 foot controller here.

3. FOOT SWITCH connector
Connect an optional VOX VFS2 foot switch here.

4. LINE OUTPUT L/R jacks
Connect your audio playback system here.

5. LINE INPUT L/R jacks
Here you can input a line-level audio signal.
If you’re using the JamVOX Monitor with other software that supports CoreAudio 
or ASIO, connect the output jacks of your synthesizer, other electronic instrument, 
or audio source to these jacks.
Note The JamVOX Monitor gives priority to the front panel input jacks. These rear 

panel input jacks cannot be used if a guitar or mic is connected to the front 
panel input jacks. If you want to use these jacks, disconnect your guitar and 
mic from the front panel input jacks.

1 2 3 4 5

AUX IN

OUTPUT

Audio system etc.

Korg EXP-2

Synthesizer, Audio system etc.

VOX VFS-2

Computer
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Windows XP
To install the software in Windows XP, proceed as follows.

Don’t connect the JamVOX Monitor to your computer until you’ve 
installed the JamVOX Driver and Software.

1 Insert the installation CD into your CD drive. The installer will start up.

2 Click [Install], and proceed as directed by the on-screen instructions.

Note Sibelius Scorch is the web browser plug-in to view the scores from GuitarIn-
structor.com. If you want to install this plug-in, click and select the Sibelius 
Scorch installer. In certain cases, it may take some time for the Sibelius Scorch 
installer to start up. If so, please wait until the installation screen appears.

3 When the installation is finished, click the [Close] button to exit the installer.

4 A screen will tell you to connect the JamVOX Monitor to your computer. Click 
the [OK] button, and use the USB cable to connect the JamVOX Monitor to 
your computer. In the lower right of the Windows screen, there will be a mes-
sage saying “Your new hardware is installed and ready to use.”

Note When “Found New Hardware Wizard” appears, install the driver as directed 
by the on-screen instructions.

When “A problem occurred during hardware installation.” appears in the 
lower right of the Windows screen, reconnect the JamVOX Monitor.

5 Double-click “JamVOX” on the desktop.

6 Click [Install], and install the JamVOX USB Driver as directed by the on-screen 
instructions.

7 When the installation is finished, click the [OK] button to exit the installer.
Note On a Windows computer, you’ll need to perform the step from 4 to 7 again if 

you connect the JamVOX Monitor to a different USB port.
7
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Windows Vista
To install the software in Windows Vista, proceed as follows.

Don’t connect the JamVOX Monitor to your computer until you’ve 
installed the JamVOX Driver and Software.

1 Insert the installation CD into your CD drive. The installer will start up.

2 Click [Install], and proceed as directed by the on-screen instructions.

Note Sibelius Scorch is the web browser plug-in to view the scores from GuitarIn-
structor.com. If you want to install this plug-in, click and select the Sibelius 
Scorch installer. In certain cases, it may take some time for the Sibelius Scorch 
installer to start up. If so, please wait until the installation screen appears.

3 When the installation is finished, click the [Close] button to exit the installer.

4 A screen will tell you to connect the JamVOX Monitor to your computer. Click 
the [OK] button, and use the USB cable to connect the JamVOX Monitor to 
your computer. In the lower right of the Windows screen, there will be a mes-
sage saying “Your devices are ready to use.”

When “Device driver software was not successfully installed.” appears in the 
lower right of the Windows screen, reconnect the JamVOX Monitor.

5 Double-click “JamVOX” on the desktop.

6 Click [Install], and install the JamVOX USB Driver as directed by the on-screen 
instructions.

Note In certain cases, it may take some time for the driver installation.

7 When the installation is finished, click the [OK] button to exit the installer.
Note On a Windows computer, you’ll need to perform the step from 4 to 7 again if 

you connect the JamVOX Monitor to a different USB port.
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Mac OS X
To install the software in Mac OS X, proceed as follows.

Don’t connect the JamVOX Monitor to your computer until you’ve 
installed the JamVOX Driver and Software.

1 Insert the installation CD into your CD drive, and double-click the installer. 
Then proceed as directed by the on-screen instructions to install the JamVOX 
Software.

2 When installation is finished, click [Close] to exit the installer.

Although JamVOX Monitor is recognized by Mac OS X and appears in the 
Sound System Preferences when the device is connected without installing 
JamVOX software, the device does not work properly, no sound is provided. 
In this case, please disconnect the device and install JamVOX software from 
the software CD-ROM, then connect the device again.
9
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Setup

This section explains how to set up JamVOX.

You must install the JamVOX Driver and Software in your computer before 
you connect the JamVOX Monitor to your computer. (See “Installing the soft-
ware” on page 7.)

Turn the knobs of the JamVOX Monitor to their minimum position before 
you connect it to your computer.

1 Use the included USB cable to connect the JamVOX Monitor to your computer. 
(See “Rear panel” on page 6.)
When you connect the JamVOX Monitor to your computer, the JamVOX Mon-
itor will be powered-on, and the JamVOX Software will automatically start up.

2 Connect your guitar to the JamVOX Monitor’s GUITAR IN jack. (See “Front 
panel” on page 5.)

3 While playing your guitar, use the JamVOX Monitor’s MONITOR LEVEL 
knob to adjust the volume.

If the JamVOX Software doesn’t start up when you connect the JamVOX 
Monitor, check the following points.

• If you’re using a USB hub, make sure that it’s a self-powered USB hub. The 
JamVOX Monitor won’t work with USB hubs that are not self-powered.

• If you are using a self-powered USB hub, try connecting the JamVOX 
Monitor directly to a USB port of your computer, and see whether it works 
correctly. Also try disconnecting all connected USB devices, and see 
whether the JamVOX Monitor will work by itself.

• If the JamVOX Software still does not start up even after you’ve checked 
the above points, start up the software in the following way.
Windows XP / Vista
From the taskbar, click [Start] → [All Programs], and from the menu 
choose [VOX] – [JamVOX] – [JamVOX].
Mac
In the “Applications” folder, double-click “JamVOX.”

Do not connect the JamVOX Monitor to a USB port or USB hub that out-
puts a voltage higher than the 5V defined by the USB specification. Be 
aware that if you’re using a self-powered USB hub, using the wrong AC 
adaptor with it may damage the JamVOX Monitor.
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In this section we’ll explain the basics of using JamVOX by taking you through the 
actual steps of operation.

Step1 Listen to the sound of the guitar programs

1 Click the Program Select buttons (q/u) located at the right of the Guitar pro-
gram name.
Clicking these buttons will move up or down through the programs one by 
one. Play your guitar to try out each program.

HINT You can also use other ways to select programs. In the Help menu, click 
“Owner’s Manual...” to view the JamVOX Owner’s manual, and refer to the 
section “Selecting programs.”

2 Click the Amp/Cabinet name displayed above the 
Effect routing section.
In the Amp/Cabinet catalog that appears, you can 
change the amp/cabinet.

HINT You can also change the effect units in the same way.

3 Try dragging and dropping an effect device to the 
location where you want to connect it.
You are free to change the connected order of all of the effect units.

HINT The amp/cabinet and effect units can be adjusted in their corresponding con-
trol panel. The Effect control panel is shown for the effect device you select by 
clicking.

Effect routing

Program Select buttons

Guitar program
 name

Amp/Cabinet
 control panel

Effect Ctontrol
 panel
11
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Step2 Play back a song and cancel the guitar part

1 Add song data from your computer to the library by dragging and dropping it 
into the Main list.

The following formats of song data can be added to the library and 
played: WAV (.wav/.wave), AIFF (.aif/.aiff), MP3 (.mp3), Windows 
Media Audio (.wma, supported only in Windows), and AAC (m4a, sup-
ported only if QuickTime 7 is installed). Song data protected by DRM 
(Digital Rights Management) cannot be played.

2 Double-click the name of a song you added.
The song will play.

HINT To adjust the volume, use the fader located in the right side of the Mixer.

3 Drag the Progress bar pointer to find the guitar solo within the song, and play 
it back.

4 Click the GXT button.
The guitar solo will be removed 
from the playback.

HINT The effectiveness of the cancella-
tion will depend on how the gui-
tar solo is mixed. In the GXT edit 
panel, try adjusting the cancella-
tion effect by dragging the pointer 
and the gray area.

HINT You can use the Extract button of the GXT edit panel to isolate and emphasize 
the guitar solo in the playback. Using this in conjunction with the Tempo 
change function (which lets you slow down the playback speed without 
affecting the pitch) can be helpful when you’re practicing.

HINT For details on GXT, click the Help menu item “Owner’s Manual...” to access 
the JamVOX Owner’s manual, and refer to the section “GXT (Guitar XTrack-
tion) function.”

Mixer GXT button

Main listLibrary

Record button Progress bar

GXT edit panel
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Step3 Perform along with the song
Now you can simply play your guitar along with the song!
To record your performance (along with the song), just click the Record button.
HINT Use the fader located in the right side of the Mixer to adjust the volume of the 

song, and the LOUDNESS knob to adjust the high/low boost. Use the left 
fader to adjust the guitar’s volume, and the PAN knob to adjust its stereo 
position.
Depending on the song that’s playing, raising the LOUDNESS knob may 
cause distortion. If so, lower the fader.

HINT By using the Pitch change function which changes the pitch without affecting 
the playback speed, you can match the song to the tuning of your guitar. This 
is also convenient if your guitar is tuned in regular tuning and you’re playing 
along with a song that is detuned.

JamVOX has many other convenient functions such as Loop playback of songs, 
automatic changing of guitar programs, and downloading/uploading of various 
programs.
Please read the Owner’s manual to learn how you can take full advantage of Jam-
VOX’s potential!

Importing the guitar karaoke track CD
Here’s how to import the bundled guitar karaoke track CD into the JamVOX software.

1 Insert the music CD into your computer.
Normally, Windows will display a dialog box asking you to choose an action, 
and Mac will start up iTunes. We will not use these in this example, so simply 
close the dialog box or iTunes.

2 From the File menu, choose “Import CD...”.
The Import CD dialog box will appear. This dialog box will show the titles and 
artist names for the songs on the CD.

The song titles and artist names will be shown only for this bundled CD. If 
you’re importing another CD, you’ll need to enter the song title and artist 
name into the JamVOX software after importing.

3  If there are any tracks you don't want to import, click them to clear their check 
boxes.

NOTE If you want to change the audio format in which the tracks will be imported, 
change the setting in the Preferences dialog box.

4 In the lower right of the dialog box, click the “Import” button.
Wait until importing has been completed.

The JamVOX software won’t be able to import the CD if you’re using a Win-
dows computer whose CD/DVD drive is an external drive. You'll need to use 
other software that is able to import a CD from an external drive, and then 
add the resulting audio files into the JamVOX software.
13
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Main specifications
JamVOX Software
Programs
Guitar programs: 100 or more

Effects
Amp models: 19
Cabinet models: 12
Effect models

Pedal effects: 18
Modulation effects: 12
Delay effect: 11
Reverb effects: 15
Noise Reduction: 1

Operating requirements
Mac OS X
CPU: PowerPC G4 / 1.5 GHz or higher, or Intel CPU
RAM: 1GB or larger
Display: 1,024 x 768 – 32,000 colors or higher
OS: Mac OS X 10.4 or later

Windows
CPU: Pentium4 / 2.0 GHz or higher
RAM: 1 GB or larger
Display: 1,024 x 768 – 16 bit colors or higher
OS: Windows XP SP 2 or later, Windows Vista SP 1 (32-bit) or later

JamVOX Monitor
Power supply: USB bus power
Rated Output: 0.75W + 0.75W
Current consumption: 500 mA
Dimensions (W x D x H): 240 mm x 160 mm x 122.5 mm (9.45" x 6.30" x 4.82")
 (not including protrusions)
Weight: 2.4kg (5.29lbs.)

Included items
USB cable, installation CD (contains JamVOX Software, Drivers, and Owner’s 
manual), two audio CDs (karaoke songs for guitar), installation/setup guide (the 
document you’re reading)

Specifications and appearance are subject to change without notice for improve-
ment. (Current as of June 2008)
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If you have questions regarding this product, please contact the VOX distributor 
for the country in which you purchase it. You can find local distributor at http://
www.voxamps.com/contact/voxworldwide/.
In order to receive product support, you must have registered this product. We 
cannot provide service if we are unable to verify that you have registered.

Information you must provide when contacting us
When you contact us, please provide the following information. We cannot pro-
vide service if you do not give us this information.

• Your name and E-mail address (as registered on JamVOX-Online)

• The serial number of this product

• The name and version of this product (shown in the About screen of the soft-
ware)

• Details of your system
Manufacturer and model of your computer:
Type of CPU and its clock speed:
Amount of memory installed:
Total capacity and free area of the installed hard disk:
Operating system and version:
Driver version:
Other computer peripherals:

• Your question (in as much detail as possible)

Before you contact us, please refer to the “Owner’s Manual...” and “Help 
menu FAQ” to see whether they contain an answer to your question.

We cannot answer questions regarding basic operation of your computer, 
basic setup for using your computer for music production, how to create 
songs or sounds, or questions related to products made by other companies.
15
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